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Salcom Product Documentation 
 

 

This document is designed to familiarise you with Salcom products and guide you through the 

hardware, configuration, installation and overall system management.  

Salcom is an environmentally conscious company and in an effort to conserve paper no longer 

prints manuals with shipped products.  All relevant documentation can be downloaded in PDF form 

from our website www.salcom.com 

 

 

  



P a g e  | 2 

 

   

12-62-0000 VHF & UHF TRANSMITTER  Product Manual 

   
Sea Air and Land Communications Ltd, 10 Vanadium Place, Addington, Christchurch 8024, New Zealand         February 2019 

Warranty and Disclaimer 
 

 

Salcom products are warranted for a period of 12 months from the date of purchase against faulty 

materials and workmanship. Should any fault occur the unit should be returned to the vendor, freight 

pre-paid. Please include a description of the fault to assist with prompt return. Any unauthorised 

alterations or repairs will invalidate the warranty. 

All information provided in this document is carefully prepared and offered in good faith as a guide 

in the installation, use and servicing of Salcom products. Installers must ensure that the final 

installation operates satisfactorily within the relevant regulatory requirements. Salcom accept no 

responsibility for incorrect installation. We reserve the right to change products, specifications and 

installation data at any time without notice 
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 Product Overview 
 

 

The 12-62 Series transmitters are available as VHF and UHF units, with user-programmable power 

outputs ranging from 50 milliwatts to 5 watts and a high VSWR tolerance. Using programming 

software, each model can be tuned across its full frequency range with no hardware adjustments. 

They are capable of operating as NRZ or POCSAG transmitters. The built-in POCSAG encoder can 

be enabled or disabled as required. 

In addition to a direct/RS232 buffered serial port, an on-board USB port enhances the range of 

applications to which the transmitter can be applied. Input / Output expansion is also possible via 

an external RJ45 interface 

The USB, RS232 ports can be used to initiate paging transmissions using the Salcom proprietary 

protocol, or Telocator Alphanumeric Protocol (TAP) PG1 PET (Paging Entry Protocol). These ports can 

be used concurrently making it possible to connect a telephone interface unit and still initiate 

paging transmissions via the USB port, with the RF output being through a standard BNC termination. 

The unit supports 4 discrete inputs with a different pre-programmed message on high and/or low 

transition, plus voltage detection messages on the power input, having programmable debounce 

delay control. They may be used to initiate relay commands for remote control applications. 

Provision to transmit a message more than once and variable time between transmissions are 

catered for. 

The 12-62 supports multiple message queuing, and will queue up to eight 240-character messages, 

or as many smaller messages that will fit into the available memory buffer (up to 80).  Pre-defined 

input messages are limited to a maximum length of 40 characters which may be configured using 

the Salcom programming software. Control via the USB or Serial port is achieved using ASCII 

character commands. 

A watchdog is available to initiate an action or transmit the state of selected inputs at a 

programmable frequency. 

The 12-62 can be configured to transmit a warning message when the power supply (battery) goes 

below a user specified minimum level and above a user specified maximum level. 

Configuration of the transmitter is performed via the USB port or the serial port using the Salcom 

programming application which allows for the setting of all operational parameters. 

The 12-62 is housed in an attractive, durable extruded aluminium case with provision on the base 

plate for wall mounting.  
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Product Features - Overview 
 

 

The 12-62 comes with several features that make the 12-62 a versatile solution to your 

communication needs. Key features are overviewed below, with more details of their use provided 

later in this manual. 

• Messaging: The 12-62 supports pager messaging and can transmit 3 types of POCSAG 

message (alphanumeric transmissions, numeric transmissions and tone only transmissions), 

with any one of 4 function levels. 

 

• Store & forward: Can be configured to operate as a store & forward transmitter. This is when 

a transmitter is designated as a source, and a receiver listens to the source relaying the 

message to another transmitter for retransmission. Configurable as an optional feature. 

 

• Low Power Mode: In Low Power Mode the 12-62 will consume approximately 17.5mA until the 

interrupt line INT4 goes low which will wake the 12-62 up into its normal standby state 

consuming 35mA. 

 

• Duplicate Message Reject: when enabled a database of the last 20 messages sent is 

maintained. All of the entries are progressively aged out. The age out time of entries in the list 

can be set from 1-255 seconds. Configurable as an optional feature. 

 

• Simulcast Modulation Delay: when enabled, allows the user to configure the transmission 

delay for modulated data. This delay can be configured to be between 10uS and 2550uS. 

 

• Over Temperature Cutout: If the transmitter operates for extended periods in a hot 

environment, a protective thermal cutout may operate to reduce the output power to a safe 

level. It will reset when the unit temperature has fallen to below 70 deg.  

 

• Aerial Mismatch: when enabled, allows reporting when an aerial is disconnected or 

damaged. If a problem is encountered along with error reporting the power is reduced to a 

level that is not likely to damage the transmitter. The feature must be self-calibrated for each 

installation before use. 

 

• Extended database: The 12-62 database now supports up to 1,000 CapCode/CAP codes. 

These can be imported via the enhanced 12-62 configuration tool which allows for the import 

of either .CSV or Text files. 
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Connectors and Pin-Outs 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Table 1: Connectors and Indications 

Item Description Designation 

1 12V Supply P1 

2 USB S8 

3 Inputs/Outputs (RJ45)  S10 

4 Serial (RJ12/6) S2 

5 Transmit LED (Red) L1 

6 Power LED (Green) L2 

Table 2: Pin connections for S2 

(RJ12/6 Serial) connector 

 Table 3: Pin connections for S10 (RJ45 

Inputs/Outputs) connector 

Pi

n 
Connection  Pin Connection 

1 Ground  1 PTT OUT, 50mA max 

2 Interrupt  2 Ground 

3 SCL  3 Discrete Input 4 

4 SDA  4 Discrete Input 3 

5 RS232 Tx  5 Discrete Input 2 

6 RS232 Rx  6 Discrete Input 1 

   7 PTT Input for NRZ operation 

   8 Modulation Input for NRZ 

operation 
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Physical Description 
 

The 12-62 is installed in an extruded aluminum case with chassis holes for easy mounting. The 

following figure shows the dimensions of the 12-62 chassis and mounting holes. 
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Installation 
 

Power Supply 

The power supply is connected via PI, green power connector to +13.8 Volts DC and Ground. The 

unit is protected against reversed supply connections. The power source must be reasonably noise 

free. 

Radiation Hazard: Important! To comply with FCC Controlled/Occupational Exposure Limits the 

aerial must be positioned or mounted to operate at least 0.26 metres away from Operational Staff 

and 0.57 metres away from the general public. Use only the aerial supplied. 

Antenna Installation 

It is recommended to site the aerial a few metres away from the unit to avoid the possibility of RF 

feedback and causing potential problems with the transmitter operation. An external (outside) 

aerial is preferable and will provide better radio coverage. A suitable antenna must be connected 

to the unit via the BNC connector on the end plate of the unit. The aerial connection should present 

a nominal load of 50Ω, with a VSWR of better that 1.8:1. 

The Salcom unit is designed to operate reliably over large distances, however the actual distance 

can vary depending on the type of location, obstructions, local radio interference and antenna 

system used. 

Powering-Up 

External indicators consist of a power indicator GREEN LED, normally flashing ON once per second 

to indicate healthy microcontroller operation. 

After a debounce delay, the green LED will flash rapidly if the low supply detector is activated. The 

RED LED will indicate when the unit is transmitting. A flashing RED LED indicates the unit cannot 

transmit as either the synthesiser is out of lock, the 12-62 is critically hot or an internal fault has been 

detected. 
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Programming 
 

Preparing to Use the Programming Software 

To change the field programmable options, the unit must be connected to a PC using Windows XP 

or later, running the 12-62 configuration tool programming software, downloadable from Salcom’s 

website http://www.salcom.com/media/software/Salcom-1262-configuration tool-v2109.msi 

 

Note: The 12-62 must be powered during programming with a nominal +13.8V to the power 

terminals. 

 

Connection should be via either the 

(preferred) USB port S8, using the supplied 

USB to USB mini cable, or the standard serial 

port S2 to a serial port on the PC i.e. DB9 

connector.  

When connected to your PC using the USB 

to USB mini cable a (virtual) com port will 

be created for that connection on your 

PC.  

 

Note: To use the USB connector with older computers, a virtual COM port USB driver may be required 

to be installed. To install the USB driver (CP210x_VCP_Win2K_XP_S2K3.exe), run the driver installer, 

which can be downloaded for your operating system, from Silicon Laboratories: 

https://www.silabs.com/products/development-tools/software/usb-to-uart-bridge-vcp-drivers  

 

Note: If you do not have a serial cable you can make one with the S2 connections as shown in the 

section Connectors and Pin-outs in this document. Alternatively purchase a Salcom serial 

programming cable, part number 12-45-0000. 

 

Note: Using the standard serial port S2 with a serial to USB cable will not work due to the high speed 

of the USB port in relation to the serial S2 connection of the 12-62.  
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Getting started with the Programming 

Software 

Once correctly connected, load the 12-

62 configuration tool programming 

software, this should bring up a screen as 

shown opposite: 

 

This is the main screen from where you 

can change the settings of your 12-62, 

but before you can change any settings 

you need to connect your PC to your 12-

62. 

 

To connect your PC to your 12-62 select 

Options and then General this will load 

the General Settings screen, as below 

 

Click on the Com Port dialog arrow to 

select the Com Port your 12-62 is 

connected to. 

Note: Ensure that the 12-62 configuration 

tool has the correct com port selected. 

 

Next select “OK” to return to the above 

screen. Press connect. The status at the 

bottom of the 12-62 configuration tool will 

indicate if successfully connected. 

 

To get a valid set of parameters to start 

your programming configuration, either 

press the read button. This will load all 

settings of the 12-62. 

Or alternatively load a configuration tool 

configuration file, by selecting the “File-

>Load” menu item and browsing and 

selecting a saved configuration. 
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Note: One of these actions is recommended before any changes can be programmed to ensure 

the unit is not programmed with the configuration tools default values. 

After programming, the configuration tool will provide feedback if the user selected operations are 

successful. 

 

Using the Programming Software 

The 12-62 configuration tool allows the user to configure the following characteristics: 

• Input actions, watchdog, low supply detector and POCSAG transmission settings 

• Pre-defined messages 

• RF frequency and output power 

• 1,000 pager numbers for use with the Salcom 12-36 telephone interface. 

Use the mouse to select the configuration fields for each feature, which you want to change and 

then select ‘Program’ to update your 12-62’s configuration. 

Note: After programming the 12-62 you must select “Disconnect” for the changes to take affect and 

for the 12-62 to return to its normal operational state. 

 

Configuration tool Input Configuration 

Low / High Input: Define the action that is 

to occur when either a low or high input is 

activated. 

 

Input: All inputs may be configured in a 

similar fashion, including supply voltage 

monitoring. The input drop down box 

provides support for the 4 inputs (Settings 

“1” to “4”), available on connector S10, 

and the “Battery”. 

Each input can have a message defined 

for both its high and low state. With the 

input parameters being configured as 

shown below:  

The “Battery” input is used for setting a 

minimum and maximum battery voltage 

warning.  See later under “Min Batt v” and 

”Max Batt v” for configuration.  
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Pager type: “Alpha Numeric” or “Numeric”. Tone only pagers are supported by ensuring that the 

message field is left blank. 

 

Beep Level: Page beep level having settings of “1” default to “4”. 

 

CapCode Code: Pager ID. Valid Codes are: 

Ranges 

0000008 to 2007663 

2007672 to 2045055 

2045064 to 2097143 

 

Default CapCode code of “1234567” 
 

Note: 0000000 may be used as a “drop” code. This may be used for the watchdog when the 

watchdog is used, but a watchdog message is to be suppressed. 

 

Message: User message, up to 40 characters in length. 

 

Transmission Count: How many times that message will be sent if triggered. Valid settings are ”1” to 

”9” sends 

 

Enabled: When selected, the configured message will be sent when triggered. 

 

Resend with Watchdog: When “Resend with Watchdog” is selected, the input message will be sent 

periodically as configured. 

Note: See below, “configuration tool Configuring a Watchdog” below, for how to configure the 

Watchdog.  

 

POCSAG Rapid: When selected, “POCSAG Rapid“ is used. Here the data size is minimised to 

significantly speed up transmission times.  

Note: “POCSAG Rapid” will not work with pagers. 

 

While Held: When the “While Held” option is selected, when the input is held in its selected trigger 

state (low or high), the message will be transmitted repeatedly until the input is no longer held.  
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Note: “POCSAG Rapid” together with “While Held” provides a means for a very responsive system 

when used with a receiver such as the 12-84. 

Note: that in order to use “POCSAG Rapid” a compatible receiver must be used, such as the 12-84. 

 

Initial Input State: Input messages are sent when transitioning to the enabled state.  

 
If on start-up “Current” has been selected the current input state is read, so that the input message 
will not be sent on start-up. 

 
If “High“ is selected, the input is assumed to be high on startup, the transition to low resulting in a 

message being transmitted (if enabled, and the input is in the high state). 
 
If “Low” is selected, the opposite will occur, the input is assumed to be low on startup, the transition 

to high resulting in a message being transmitted (if enabled, and the input is in the high state). 
 

Default setting of “Current”. 

 

 

Min Batt v: Used to send, a user defined, a low battery warning message to a specified CapCode 
code. 

 

Volts Description 

10.0 Minimum Voltage 

11.2 Default 

13.0 Maximum Voltage 

0.1 Step size 

  

Default message of “Battery Low!” 
 
 

Max Batt v: Used to send, a user defined, 
high battery warning message to a specified 
CapCode code.  

 

Volts Description 

Min Batt v + 0.2 Minimum Voltage 

12.2 Default 

13.0 Maximum Voltage 

0.1 Step size 

 
Default message of “Battery High!” 
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Status Messages: A display is provided to give status updates of connecting and programming the 
12-62. This display can be cleared using the “Clear” button below it. 

 

 

configuration tool Configuring a Watchdog 

To configure the Watchdog select “Options” and then “Watch Dog” for the Watch Dog screen as 

shown opposite to be displayed. 

 

Pager type: “Alpha Numeric” or “Numeric”. Tone only pagers are 

supported by ensuring that the message field is left blank. 

Default setting of “Alpha Numeric”. 

 

Beep Level: Page beep level having settings of “1” default to “4”. 

 

CapCode: Pager ID. Valid Codes are: 

Ranges 

0000008 to 2007663 

2007672 to 2045055 

2045064 to 2097143 

 
Default CapCode code of “1234567” 

 

Note: 0000000 may be used as a “drop” code. This may be used for the watchdog when the 

watchdog is used, but a watchdog message is to be suppressed. 

 

Message: User message, up to 40 characters in length. 
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Watch Dog Timeout: Sets the time between Watchdog messages being sent 

Setting Description 

0 No Watchdog 

0.1 Minimum Frequency = 6s 

1 Default 

720 Maximum Frequency = 720mins (12hrs) 

0.1 Step size = 6s 

 

Configuration tool General Configuration 

Selecting “Options->General“ will display the general configuration screen as shown below. The 

items that may be set are described below. 

 

Com Port: The Com Port through which the PC is connected to the 12-62, as described earlier.  

 

Protocol: Allows the serial protocol to be changed, see later for available protocols. 

 

Baud Rate: Changing this setting will result in 

all configured input messages to be 

transmitted at the selected baud rate. 

Available settings are ”512” default or ”1200” 

baud. 

Note: baud rate changes are not applied to 

serially generated Salcom protocol messages. 

 

Enable CapCode DB Support: This enables 12-

36 support, which will allow the Salcom 12-36-

0000 telephone interface to be configured.  

Note: This feature only needs to be selected if 

you are using the Salcom 12-36-0000 

Telephone Interface. 

Note: When enabled, the “Preset Messages” 

and “CapCode Database” pages will be available under “Options-> CapCode DB support”. 

Default “Not Selected” 
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Protocol Default CapCode: Only available with the ASCOM protocol. 

Note: This feature only needs to be selected if you are using ASCOM protocol. 

Default CapCode code of “0000999” 

 

Input Debounce: The time delay, in milliseconds (ms), between the input being triggered and the 

message being sent. 

Setting Description Debounce Time 

100 Minimum debounce time 100ms 

500 Default 500ms 

2000 Maximum debounce time 2000ms 

100 Step size 100ms 

 

Resend Delay: When an input has been configured with a transmission count greater than 1, the 

resend delay is the delay in seconds before sending the message again. 

Setting Range 

0 Minimum  

5 Default 

30 Maximum  

1 Step size 

 

Max ON Air: When the 12-62 is transmitting, this setting controls how long the transmitter may be 

continuously on-air. When this period has been exceeded the transmitter ceases transmission and 

will remain off-air for the duration defined by the “Max OFF Air” setting. This setting has no effect 

when External Modulation has been selected. 

Setting Description 

0 Disabled, no rest required. 

1 Minimum duration before rest 

60 Default 

300 Maximum duration before a rest 

1 Step size 
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Max OFF Air: When the 12-62 has exceeded the “Max ON Air“ continuous transmission time, the 

“Max OFF Air“ setting controls how long the transmitter will remain powered down before allowing 

transmission to continue. 

Setting Description 

0 Minimum duration before sending next message 

10 Default 

300 Maximum duration before sending next message 

1 Step size 

 

Invert Tx data: Internally generated data is inverted when “Invert Tx data” is selected and ”Internal 

Modulation” is selected. The “Invert Tx data“ option is unavailable when external modulation is 

selected. 

Default “Not Selected” 

 

Modulation: If external modulation has been selected then no serial or input controlled messages 

will be sent, data transmission is solely controlled by the PTT and Modulation inputs on connector P2. 

When internal modulation is selected then the PTT and modulation inputs do not serve any purpose. 

Setting Value 

0 Internal (default) 

1 External 

 

Unit Power Level: The power level to transmit at.  

Setting Power Level 

0 4W(default) 

1 2W 

2 1W 

3 500mW 

4 250mW 

5 100mW 

6 50mW 

Note: that the power will be reduced when the 12-62 exceeds 70 degrees Celsius.  
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Deviation: How much the selected frequency deviates by when transmitting data.  

Setting Value 

0 4.5KHz (default) 

1 2.25KHz 

2 <Custom> 

Note: the custom setting is not to be used unless the 12-62 has been factory set to support this option. 

 

Lead In: The lead-in defines, in seconds, how long the transmitter carrier will be present before data 

transmission commences. 

Setting Description 

0.1 Minimum lead in time (s) 

0.5 Default (s) 

10.0 Maximum lead in time (s) 

0.1 Step size (s) 

 

Lead Out: The lead-out time controls how long, in seconds, the transmitter will remain on air after 

data transmission has finished. 

Setting Description 

0.1 Minimum lead out time (s) 

0.5 Default (s) 

30.0 Maximum lead out time (s) 

0.1 Step size (s) 

 

Frequency: Configures the transmission frequency.  

Frequency Minimum Maximum 

VHF 138.0000 174.0000 

UHF 427.5000 475.0000 

Note: The selected frequency must be evenly divisible by the channel spacing. 
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Channel Spacing: Defines the frequency step resolution. 

Settings 

5kHz 

6.25kHz 

10kHz 

12.5kHz (default) 

Note: To obtain a channel spacing of 25kHz, select 12.5kHz as multiples of the selected frequency 

also applies. 

 

Sent Response: Controls the serial response when a page has been transmitted. May be used to 

provide a controlling application with feedback that another message may be submitted for 

transmission.  

Setting Description 

0 For no response 

1 to send [SENT]+whole message 

Custom Any user defined response up to 40 characters in length. 

Default setting with message “Page Sent” 

Note: Selecting ”1” will allow feedback to the user which message has been transmitted, but may 

introduce backwards compatibility problems with applications supporting other Salcom products.  

 

Configuration tool Reset Options 

Selecting “Options->Reset to Factory Defaults“ will allow the user to restore the 12-62 to its original 

factory state. This option will not affect any factory calibrated settings. 

 

Configuration tool Configuration files 

The current 12-62 configuration can be saved using “File->Save“. Previously saved configuration files 

can be loaded and edited with, or without a 12-62 being connected. 
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Using Serial Commands to Program your 12-62 
 

 

Serial Commands 

The 12-62 can be controlled using serial commands this allows the control of the 12-62 from another 
device it also means a suitable terminal program can be used to send commands and receive the 
results from the 12-62 unit. 

Commands are issued using the 9600 N: 8:1 serial format. 

Note: The majority of commands are preceded by a single ‘*’, with some requiring two ‘**’ and SN? 

not requiring any asterisks. The following descriptions include the asterisks (*) and carriage returns 

(<CR>) to aid clarity. 

Note: Similar to programming, the 12-62 will be connected to a PC through a suitable Com Port. 

Follow the specific program’s instructions for guidance on how to connect to the Com Port. 

 

Configuration tool Commands 

Configuration tool commands, allow any of the commands that are available through the 
configuration tool program to be actioned through a serial interface using serial commands. 

• configuration tool_INPUT_L= (Set input message and settings – low) 

o Format:  configuration tool_INPUT_L=a,b,c,d,e,ffggggggg h <message 

Parameter Descriptor Valid Values 

a Input 1, 2, 3, 4 or 17 (Battery) 

b Enabled 0 (Disabled) or 1 (Enabled) 

c Resend with Watchdog 0 (Disabled) or 1 (Enabled) 

d No. Times Message Sent 1 to 9 

e Initial Input State 0 (low), 1 (high) or 2 (current) 

ff Pager Type CA or ca for (Alpha Numeric) 

CN or cn for (Numeric) 

ggggggg CapCode Code 0000008 to 2000000 

h Beep Level 1, 2, 3 or 4 

<message> Message to be sent 248 characters 
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Note: Using upper case CA or CN transmits the message at a baud rate of 512, 

whereas lower case ca or cn, transmits the message at 1,200 baud rate. 

o Typical Usage:  *configuration tool_INPUT_L=1,1,0,1,2,CA1234567 2 Horse Down <CR> 

*configuration tool_INPUT_L=1,1,0,0,2, <CR> to set options without 
sending a message. 

o Responses:   OK or ERROR 

 

• configuration tool_INPUT_L?= (Get input message and settings – low) 

o Typical Usage:  *configuration tool_INPUT_L?=1 <CR> (get message for input 1) 

o Typical Response:  “1,0,1,2,CA1234567 2 Horse Down” or ERROR. 

 

• configuration tool_INPUT_H= (Set input message and settings – high) 

o Format:  configuration tool_INPUT_H=a,b,c,d,e,ffggggggg h <message> 

Parameters as for Input Low. 

o Typical Usage:  *configuration tool_INPUT_H=1,1,0,1,2,CA1234567 2 Horse Down  
<CR> 

*configuration tool_INPUT_H=1,1,0,0,2, to set options without 
sending a message. 

o Responses:   OK or ERROR 

 

• configuration tool_INPUT_H?= (Get input message and settings – high) 

o Typical Usage:  *configuration tool_INPUT_H?=1 <CR> (get message for input 1) 

o Typical Response:  “1,0,1,2,CA1234567 2 Horse Down” or ERROR. 

 

• configuration tool_RAPID= (set which inputs will use POCSAG RAPID). 

o Format:  configuration tool_Rapid=a,b 

 

 



P a g e  | 22 

 

   

12-62-0000 VHF & UHF TRANSMITTER  Product Manual 

   
Sea Air and Land Communications Ltd, 10 Vanadium Place, Addington, Christchurch 8024, New Zealand         February 2019 

Parameter Descriptor Valid Values 

a 3 digit decimal bitmap for low input states 000 to 015 

b 3 digit decimal bitmap for high input states 000 to 015 

Below is shown the decimal bitmap settings and how they affect the Inputs in terms of 

being Enabled or Disabled. 

 

Decimal 

Setting 

Input State 

Input 1 Input 2 Input 3 Input 4 

000 Disabled Disabled Disabled Disabled 

001 Enabled Disabled Disabled Disabled 

002 Disabled Enabled Disabled Disabled 

003 Enabled Enabled Disabled Disabled 

004 Disabled Disabled Enabled Disabled 

005 Enabled Disabled Enabled Disabled 

006 Disabled Enabled Enabled Disabled 

007 Enabled Enabled Enabled Disabled 

008 Disabled Disabled Disabled Enabled 

009 Enabled Disabled Disabled Enabled 

010 Disabled Enabled Disabled Enabled 

011 Enabled Enabled Disabled Enabled 

012 Disabled Disabled Enabled Enabled 

013 Enabled Disabled Enabled Enabled 

014 Disabled Enabled Enabled Enabled 

015 Enabled Enabled Enabled Enabled 

o Typical Usage:  *configuration tool_RAPID=000,000 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_RAPID? (Gets which inputs will use POCSAG RAPID). 

o Typical Usage:  *configuration tool_RAPID? <CR> 

o Typical Response:   000,000 

 

• configuration tool_WHILEHELD= (set which inputs will use the “while held” feature). 

o Format:  configuration tool_WHILEHELD=a,b 
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Parameter Descriptor Valid Values 

a 3 digit decimal bitmap for low input states 000 to 015 

b 3 digit decimal bitmap for high input states 000 to 015 

Note: See configuration tool_RAPID for decimal bitmap settings and how they affect 

the inputs. 

o Typical Usage:  *configuration tool_WHILEHELD=000,000 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_WHILEHELD? (Gets which inputs will use the “while held” feature).  

o Typical Usage:  *configuration tool_WHILEHELD? <CR> 

o Typical Response:  000,000 

Note: The same inputs in both the high and low state cannot be set at the same time – this 

will not be allowed by the firmware. 

 

• configuration tool_MIN_BATT_V= (Min battery voltage threshold, voltage at which “Low 
battery” message will be sent if configured to do so). 

Setting Description 

10.0 Minimum Voltage 

11.2 Default 

13.0 Maximum Voltage 

0.1 Step size 

o Typical usage: *configuration tool_MIN_BATT_V=11.3 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_MIN_BATT_V? (Get min battery voltage) 

o Typical usage: *configuration tool_MIN_BATT_V? <CR> 

o Typical response:  11.2 
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• configuration tool_MAX_BATT_V= (Max battery voltage threshold, voltage at which “battery 

OK” message will be sent if configured to do so). 

Setting Description 

Min Batt v + 0.2 Minimum Voltage 

12.2 Default 

13.0 Maximum Voltage 

0.1 Step size 

o Typical usage: *configuration tool_MAX_BATT_V=11.3 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_MAX_BATT_V? (Get max battery voltage) 

o Typical usage: *configuration tool_MAX_BATT_V? <CR> 

o Typical response:  12.2 

 

General Settings 

• configuration tool_PROTOCOL= (Set protocol) 

Setting Protocol 

1 Salcom (Set to support 12-36) 

2 TAP (PET) 

3 Flex (Not a full implementation) 

4 TNPP 

5 12-84 

6 SMS 

7 Gaming 

13 GENT 

14 ESPA 

16 11-10 

18 Ascom 

19 Austco 
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22 Match 

26 GPS & Pulse Count 

27 Comp 1 

28 Comp 2 

o Typical Usage:  *configuration tool_PROTOCOL=1 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_PROTOCOL? (Get protocol) 

o Typical Usage:  *configuration tool_PROTOCOL? <CR> 

o Responses:   0,1,2,3,4,5,6,C,P or ERROR 

 

• configuration tool_INPUT_DEBOUNCE= (Set input debounce period in 100ms steps – max 9 min 
0) 

Setting Description Debounce Time 

0 Minimum debounce time 100ms 

9 Maximum debounce time 1000ms 

1 Step size 100ms 

o Typical Usage:  *configuration tool_INPUT_DEBOUNCE=5 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_INPUT_DEBOUNCE? (Get input debounce period) 

o Usage:  *configuration tool_INPUT_DEBOUNCE? <CR> 

o Responses:   5 or ERROR 

 

• configuration tool_DELAY_RETRY= (How long in seconds before messages are resent) 

Setting Range 

0 Minimum  

30 Maximum  
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1 Step size 

o Typical Usage:  *configuration tool_DELAY_RETRY=5 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_DELAY_RETRY? (Get Delay Retry) 

o Usage:  *configuration tool_DELAY_RETRY? <CR> 

o Typical Response:  5 

 

• configuration tool_MAX_ON_AIR= (Max time in seconds allowed on air before a rest is required, 
either for thermal or channel usage). 

Setting Description 

0 Disabled, no rest required. 

1 Minimum duration before rest 

300 Maximum duration before a rest 

1 Step size 

o Typical Usage:  *configuration tool_MAX_ON_AIR=0 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_MAX_ON_AIR? (Get max on air time) 

o Usage:  *configuration tool_MAX_ON_AIR? <CR> 

o Typical Response:  50 

 

• configuration tool_MIN_OFF_AIR= (Min time in seconds off air before sending next message – 
Only used after max on time has expired). 

 

Setting Description 

0 Minimum duration before sending next message 

300 Maximum duration before sending next message 
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1 Step size 

o Typical Usage: *configuration tool_MIN_OFF_AIR=0 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_MIN_OFF_AIR? (Get min off air time) 

o Usage:  *configuration tool_MIN_OFF_AIR? <CR> 

o Typical Response:  20 

 

• configuration tool_INV_TX= (Invert TX data line) 

o Typical Usage:  *configuration tool_INV_TX=1 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_INV_TX? (Get TX invert state) 

o Usage:  *configuration tool_INV_TX? <CR> 

o Responses:   1 or 0 

 

• configuration tool_MODULATION= (Set Modulation Mode. 0 = Internal, 1 = External) 

Setting Value 

0 Internal (default) 

1 External 

o Typical Usage:  *configuration tool_MODULATION=1 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_MODULATION? (Get Modulation Mode. 0 = Internal, 1 = External) 

o Typical Usage:  *configuration tool_MODULATION? <CR> 

o Responses:   0,1 or ERROR 
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• configuration tool_PL= (Set Unit Power Level) 

Setting Power Level 

0 4W(default) 

1 2W 

2 1W 

3 500mW 

4 250mW 

5 100mW 

6 50mW 

o Typical Usage:  *configuration tool_PL=0 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_PL? (Get Unit Power Level) 

o Typical Usage:  *configuration tool_PL? <CR> 

o Responses:   0,1,2,3,4,5 or 6 

 

• configuration tool_DEV_MODE= (Set Deviation Mode – max 3 min 0) 

Setting Value 

0 4.5KHz (default) 

1 2.25KHz 

2 <Custom> 

Note: The custom setting is not to be used unless the 12-62 has been factory set to support 

this option. 

o Typical Usage:  *configuration tool_DEV_MODE=0 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_DEV_MODE? (Get Deviation Mode) 

o Typical Usage:  *configuration tool_DEV_MODE? <CR> 
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o Typical Responses:  0,1,2,3 or ERROR 

 

• configuration tool_LEAD_IN= (transmitter lead in time in seconds before messages). 

Setting Description 

0.1 Minimum lead in time 

10.0 Maximum lead in time 

0.1 Step size 

o Typical Usage:  *configuration tool_LEAD_IN=0.6 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_LEAD_IN? (Get lead in time) 

o Usage:  *configuration tool_LEAD_IN? <CR> 

o Typical Response:  0.6 

 

• configuration tool_LEAD_ OUT= (On time in seconds after sending a message). 

Setting Description 

0.1 Minimum lead out time 

30.0 Maximum lead out time 

0.1 Step size 

o Typical Usage:  *configuration tool_LEAD_OUT=3.0 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_LEAD_OUT? (Get transmitter lead out time) 

o Usage:  *configuration tool_LEAD_OUT? <CR> 

o Typical Response:  3.0 

 

• configuration tool_F= (Configured Frequency and Channel Spacing). 
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o Format:  configuration tool_F=a,b 

Parameter Descriptor Valid Values 

a Frequency VHF = 13800000 to 17400000 

UHF = 42750000 to 47500000 

b Channel Spacing 500, 625, 1000, 1250 (default) & 2500 

Note: Frequency and Channel Spacing is in 10s of Hz e.g. a Frequency setting of 13800000 = 

138MHz and a Channel Spacing of 1250 = 12.5KHz. 

Note: The selected frequency must be evenly divisible by the channel spacing. 

o Typical Usage: *configuration tool_F=44000000,1250 <CR>  
 

Note: If the Channel Spacing is not included, e.g. *configuration tool_F=44000000<CR> 

then the default channel spacing of 12.5kHz will be used. 

o Responses:   OK or ERROR 

 

• configuration tool_F? (Get configured frequency and channel spacing) 

o Typical Usage: *configuration tool_F? <CR> 

o Typical Response:  44000000,1250 

 

• configuration tool_SENT_RESPONSE= (Set serial port reply when a page has been sent – Max 40 
characters, default value “Page Sent”) 

Setting Description 

0 For no response 

1 to send [SENT]+whole message 

<custom> Any user defined response up to 40 characters in length. 

Default setting with message “Page Sent” 

Not set Results in the default “Page Sent” 

o Typical Usage:  *configuration tool_SENT_RESPONSE=Page Sent <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_SENT_RESPONSE? (Get page sent reply) 
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o Usage:  *configuration tool_SENT_RESPONSE? <CR> 

o Typical Responses: Page Sent (default when not set)  

   [SENT]CA1234567 2 test message (when set to 1) 

 

Watchdog Settings 

• configuration tool_WDOG_FREQ=(Set periodic watchdog timeout) 

Setting Description 

0 No Watchdog 

0.1 Maximum Frequency = 6s 

1 Default 

1440 Minimum Frequency = 1,440mins (24hrs) 

0.1 Step size = 6s 

o Typical Usage:  *configuration tool_WDOG_FREQ=5 <CR> 

o Responses:   OK or ERROR 

Note: When programming through the 12-62 Programming tool, the minimum frequency is 

720minutes (12hrs) 

 

• configuration tool_WDOG_FREQ? (Get watchdog timeout) 

o Typical Usage:  *configuration tool_WDOG_FREQ? <CR> 

o Typical Response:  5 

 

• configuration tool_WDOG_MESSAGE=(Set periodic watchdog message) 

o Format:  configuration tool_WDOG_MESSAGE=ffggggggg h <message> 

o  

Parameter Descriptor Valid Values 

ff Pager Type CA (Alpha Numeric) or CN (Numeric) 

ggggggg CapCode Code 0000008 to 2000000 

h Beep Level 1, 2, 3 or 4 
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<message> Message to be sent 248 characters 

o Typical Usage:  *configuration tool_WDOG_MESSAGE=CA1234567 4 Watchdog 

<CR> 

o Responses:   OK or ERROR 

 

• configuration tool_WDOG_MESSAGE? (Get watchdog message) 

o Typical Usage:  *configuration tool_WDOG_MESSAGE? <CR> 

o Typical Responses:  CA1234567 4 Watchdog 

 

Other Settings 

• configuration tool_FACTORY_DEFAULTS (Set factory default configuration tool Settings) 

o Typical Usage:  *configuration tool_FACTORY_DEFAULTS <CR> 

o Responses:   OK or ERROR 

 

Feature Settings 

• configuration tool_LOW_POWER= (set low power options). 

o Format:   configuration tool_LOW_POWER=a,b 

Parameter Descriptor Valid Values 

a Low Power Mode 0 (Disable) or 1 (Enable) 

b Time until shutting down after 

external interrupt wakeup. 

30 to 1800 seconds 

o Typical Usage:  *configuration tool_LOW_POWER=1,267 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_LOW_POWER? (get low power options). 

o Typical Usage:  *configuration tool_LOW_POWER? <CR> 

o Typical Response:   1,267 
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• configuration tool_STORE_FWD= (Set store forward mode. Requires optional feature enabled.) 

Setting Descriptor 

0 Disabled (default) 

1 Source (One message transmitted at a time, powering down 

after each plus delay after each message to allow forwarding 

transmitter to resend) 

2 Simplex (No messages queued from serial port when on air, 

preventing transmitted messages being sent back to itself) 

o Typical Usage:  *configuration tool_STORE_FWD=1 <CR> 

o Responses:   OK or ERROR 

 

• configuration tool_STORE_FWD? (Get store forward mode. Requires optional feature enabled.) 

o Typical Usage:  *configuration tool_STORE_FWD? <CR> 

o Responses:   0, 1 or 2 

 

• configuration tool_DUP_REJECT= (Set Duplicate reject. Requires optional feature enabled.) This 
maintains a list of the last 20 entries and compares each new entry added to the queue. 

Setting Descriptor 

0 Disabled (default) 

1-255 Time in seconds before aging out 

o Typical Usage:  *configuration tool_DUP_REJECT=25 <CR> 

o Response:   OK or ERROR 

 

• configuration tool_DUP_REJECT? (Get Duplicate reject. Requires optional feature enabled.) 

o Typical Usage:  *configuration tool_DUP_REJECT? <CR> 

o Typical Response:  25 

 

General Control 
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• SN? (Obtain Serial Number String) 

o Usage    SN? <CR> 

Note: With SN? it does not need to be preceded by an ‘*’ asterisk. 

o Typical Response:  SALCOM 12-62-0000 V1.05 00000001 

 

• configuration tool_RESET (Reset Device) 

o Typical Usage:  *configuration tool_RESET <CR> 

o Response:   SALCOM 12-62-0000 VX.XX 

 

• configuration tool_SYSTEM_SETTINGS? (Get All system settings) 

o Typical Usage:  *configuration tool_SYSTEM_SETTINGS? <CR> 

o Response Format:  a,b,c,d 

Parameter Descriptor 

a Minimum frequency 

b Maximum frequency 

c Supported Inputs 

d Protocols Supported 

o Typical Response:  425,475,4,1023 (min freq = 425MHz, max freq = 475MHz, max 
supported inputs = 4, all 10 protocols supported (protocol bitmap)) 

 

• configuration tool_BAUDRATE= (Set 12-62 baud rate). Sets all RS232 port serial comms to this 
new baud rate. Takes effect after cycling power.  

o Format:  configuration tool_BAUDRATE=aaaa,b,c,d 

Parameter Descriptor Valid Values 

aaaa Baud rate 9600, 4800, 2400, 1200 

b Parity N = No parity; E = Even; O = Odd 

c Data bits 7 or 8 

d Stop bits 1 or 2 

o Typical Usage:  *configuration tool_BAUDRATE=9600,N,8,1 <CR>  

o Typical Response:  New Baud rate – 9600,N,8,1 – Restart to take affect or ERROR 
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Note: This baud rate change only affects the RS-232 port. The USB port is fixed at 9600,N,8,1. 

Valid Settings Baud Rate 

9600 9600 no parity, 8 bits, 1 stop 

9600,N,8,1 9600 no parity, 8 bits, 1 stop 

9600,N,7,1 9600 no parity, 7 bits, 1 stop 

9600,N,8,2 9600 no parity, 8 bits, 2 stop 

9600,E,8,2 9600 even parity, 8 bits, 2 stop 

9600,O,8,2 9600 odd parity, 8 bits, 2 stop 

Note: If 9600 supplied on own then N,8,1 is assumed.  

Note: Some invalid settings will be automatically changed to a valid setting, as below: 

Invalid 

Setting 

Changed 

To 

BAUD,E,7,2 BAUD,N,7,2 

BAUD,O,7,2 BAUD,N,7,2 

BAUD,N,7,1 BAUD,O,7,1 

BAUD,E,8,2 BAUD,N,8,2 

BAUD,O,8,2 BAUD,N,8,2 

 

• configuration tool_BAUDRATE? (Get 12-62 baud rate) 

o Typical Usage:  * configuration tool_BAUDRATE? <CR> 

o Typical Responses:  9600,N,8,1 
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Product Feature - Messaging 
 

 

Overview 

The 12-62 can transmit 3 types of POCSAG message, with any one of 4 function levels:  

• Alphanumeric transmissions. Message can contain any alphanumeric ‘ASCII’ character. 

• Numeric transmissions. Message contains only Numeric characters and some symbols. 

• Tone Only transmissions (Alphanumeric or numeric with no message) 

 

Alphanumeric transmissions 

Messages can contain any alphanumeric character. The 12-62 will accept the standard ASCII 7-bit 

character set. 

 

Numeric transmissions 

Messages can contain numeric characters and some symbols. 

These can convey a telephone number, or other numerically coded information. 

The transmitted message is shorter, and therefore there is a smaller chance of errors received by 

the pager. 

The numeric character set is as follows: 0 1 2 3 4 5 6 7 8 9 [ ] - U <space> 

 

Tone Only transmissions 

Any numeric or alphanumeric paging message without an actual text message is also considered 

‘Tone Only’. A function level will control the number of beeps on the receiver (four different function 

levels can be sent). 

 

Initiating Transmission  

There are four ways of initiating a paging message transmission: 
 

(1) Using the external discrete inputs (action) 

(2) Supply detector threshold (action) 
(3) Watchdog (action) 

(4) RS232 Serial commands 
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An action is defined as a paging message, CapCode (Receiver Identification Code or capcode) 

and flags. Flags are discussed in the configuration tool (product support disk) section. 
 
External Discrete Inputs 

An action can be initiated from the 4 external inputs with an input transition to LOW (connection to 
GND) and/or HIGH (input floating or connection to >+3.5v). 
 

 

Low supply message 

After a debounce period, the low-supply detector can initiate an action for both “supply going high” 
and “supply going low” conditions. 
 

 

Watchdog 

The watchdog feature will initiate an action after a predetermined period. The watchdog also 
optionally allows the transmission of the current state of selected inputs (including supply level). 
 

 

Using the RS232 Serial Commands 

Serial commands can be “manually” issued to a 12-62 using a terminal program such as PROCOMM 
or Hyper-terminal.  
 

Tone only, numeric and alphanumeric pagers can be called using serial commands. These 

commands will be processed in parallel with other inputs actions for transmission. 
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Product Feature – Store & forward 
 

 

Overview 

The 12-62 can be configured to operate as a store & forward transmitter. This is when a transmitter is 

designated as a source, and a receiver listens to the source relaying the message to another 

transmitter for retransmission (usually located to allow coverage over an area that the source 

transmitter cannot reach). 

Enabling the Store & forward Options 

• Using the command *configuration tool_STORE_FWD=0 will disable any store & forward 

options. 

• Using the command *configuration tool_STORE_FWD=1 will configure the transmitter as a 

“Store and Forward Source”. This will ensure that only a single message is transmitted before 

powering the transmitter down again, then waiting a period of time to allow the forwarding 

transmitter sufficient time to relay the original message. 

• Using the command *configuration tool_STORE_FWD=2 will configure the transmitter in a store 

and forward “Simplex” mode of operation. When this option is set the transmitter will discard 

any messages received into the serial port while on air. This will prevent receiving any 

messages transmitted by itself. Note: The transmitter lead out delay should not be set to 0 in 

this configuration, a lead out delay of approximately 0.5 seconds should be sufficient. 

In order for the 12-62 to operate as a store & forward working with a 12-84 the 12-62 must be 

configured to support the 12-84 protocol. If this is not done the configuration tool will not allow the 

12-84 protocol to be set. 

• Send the command *SAL_SYSTEM_SETTINGS=425,475,004,0017 or     

   *SAL_SYSTEM_SETTINGS=140,170,004,0017 for a VHF system. 

• Set the protocol to 12-84 using the configuration tool. 
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Product Feature – Low Power Mode 
 

 

Overview 

In Low Power Mode the 12-62 will consume approximately 17.5mA until the interrupt line INT4 goes 

low which will wake the 12-62 up into its normal standby state consuming 35mA. 

Upon shutdown, the red led will briefly flash, and the message “Low Power Shutdown” is sent to the 

serial port. 

Serial Commands 

The command configuration tool_LOW_POWER can be used to configure the enabled state of the 

low power mode, and how long the 12-62 will remain powered until shutting down again. During the 

shutdown timer period, further transitions to the INT4 line to a low state will reset the shutdown timer.  

Refer to section “Using Serial Commands to Program your 12-62” for how to configure Low Power 

Mode. 
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Product Feature – Duplicate Message Reject 
 

 
Overview 

The 12-62 supports duplicate message reject if the feature has been enabled. When enabled a 

database of the last 20 messages sent is maintained. All of the entries are progressively aged out. 

The age out time of entries in the list can be set from 1-255 seconds. 

If more messages are sent before the list has an available slot to add the new message to – the 

oldest message in the list will be removed, and the new message put in its place. If the age time is 

correctly set (to about 30 seconds) this is unlikely to happen. 

Enabling Duplicate Message Reject 

The feature is enabled using the command  

*configuration tool_DUP_REJECT= 

Setting to 0 disables the feature. Setting to anything but 0 sets the age out time. A sensible age time 

for duplicate reject to work well (preventing ping ponging of messages between store & forward 

units) is about 30 seconds. 

Problems Arising from Duplicate Reject Usage. 

Because there is a list of messages to search each time a message is added, as the list grows (as will 

occur in a busy system), when entries are about to age-out there is a small delay of up to 2ms while 

they are checked. 

If messages are added in immediate succession (as in the case of stress testing the system – e.g. 

several messages added in the same serial command) the first character of the next message can 

sometimes be lost, and the message is not added to the queue. 

Although there is very minor performance degradation, in a real system messages would be added 

separately with a delay between messages far greater than 2ms (in reality in a store & forward 

system this would generally be at least a second between messages). 
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Product Feature – Simulcast Modulation Delay 
 

 
Overview 

The 12-62, supports modulation delay and data inversion. This modulation delay, when enabled, 

allows the user to configure the transmission delay for modulated data. This delay can be configured 

to be between 10uS and 2550uS. When configuring transmitters to operate in a simulcast 

arrangement the delay between transmitters should be 3.3uS/km separation. 

Configuring. 

1. Using the 12-62 configuration tool select the required Invert TX data option from the “General 

Settings” page. 

2. Using the 12-62 configuration tool enable external modulation under “General Settings”. 

3. Apply this configuration, then cycle power. 

4. Connect to the 12-62 using a terminal program. 

5. Issue the command “*configuration tool_MOD_DELAY=N”, where N is the modulation delay 

in 10uS steps. 

Using Modulation Delay 

• Modulation delay is only operative when modulation delay has been configured to be a non- 

zero value. This value must be set to be between 1 and 255. 

• Modulation delay operates only when the external PTT input is driven low. 

• Modulated data must be presented on the INPUT 1 pin, NOT the external modulated data 

pin. 

• Modulated data presented on the INPUT 1 pin should be via an open collector output, or 

connected bypassing the input buffering.  

Warning: Applying data at 5V levels directly to INPUT 1 will result in asymmetrical modulation – do 

not do this! 

Testing Modulation Delay 

• When correctly configured, and the external PTT pin is pulled low, the green LED will light 

solidly. Connecting an oscilloscope to the green LED will show that the LED is in fact toggling 

every 10uS. If this test signal is not present, the feature will not operate. 

• Delayed modulated data is transmitted through the same internal path as internally 

generated POCSAG data. The delayed data is also presently to the red LED. 

• A dual trace oscilloscope can be connected to the red LED and the input signal to verify 

correct delaying of modulation. 

• When the PTT pin is released, the green LED will flash normally again. 

Limitations 

• Min value 10uS, Max 2550uS 
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• Resolution is 10uS. Sampling is also only performed every 10uS. This means that when a 

modulation delay of 10uS is configured, the delay is no more than 10uS (but could be as little 

as no delay). When 200uS is configured the delay will be no more than 200uS, but could be 

as little as 190uS. 
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Product Feature – Over Temperature Cutout 
 

 

Overview 

If the transmitter operates for extended periods in a hot environment, a protective thermal cutout 

may operate to reduce the output power to a safe level. It will reset when the unit temperature has 

fallen below 75 degrees Celsius. 

Operation 

Prior to the transmitter powering up, the NTC on-board resistor is checked. If the transmitter is above 

75 degrees Celsius the maximum power level is limited to 1 watt. 

In addition to the pre-transmit power check, the temperature is checked once every second. If the 

transmitter is already operating and the temperature is above 75 degrees Celsius then the power 

will be reduced to 1 Watt (if set above 1 watt). The full power capability of the 12-62 will not be 

restored until the transmitter has powered down, and the temperature has reduced below 75 

degrees Celsius again. 

If the 12-62 is being externally modulated and the temperature exceeds 85 degrees Celsius, the 12-

62 is considered to be critically hot, and powers down. 

When critically hot, no further messages queued for processing or transmission will be allowed until 

the 12-62 has reduced in temperature below 85 degrees Celsius. In addition, attempts to enable the 

12-62 transmitter using the external PTT line will have no effect until below 85 degrees Celsius. 

If the transmitter has been controlled via the external PTT line, and for some reason the 12-62 has 

become critically hot, then the 12-62 will not transmit again until the unit has dropped below 70 

degrees Celsius. 

Notification When Over-Temperature 

When the 12-62 is above 75 degrees, but not critically hot, there is no serial or visual indication that 

the 12-62 has reduced in power. 

When the 12-62 is critically hot, the serial message “ER7 OVERTEMP” is sent out both serial ports, and 

the red LED flashes, but does not continue to flash. 

 

There is no messaging when the 12-62 temperature has reduced again. However, when a message 

is sent for transmission, there will be a suitable response to indicate if the queued message has been 

transmitted. 
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Product Feature – Aerial Mismatch 
 

 
Overview 

The aerial mismatch feature of the 12-62, when enabled, allows changes to the aerial, changes in 

RF output level and changes in drive to the power amplifier to be monitored. Based on the test result 

performed on each transmission an error message can be returned, along with control over the error 

output. 

This feature allows reporting when an aerial is disconnected or damaged. If a problem is 

encountered along with error reporting the power is reduced to a level that is not likely to damage 

the transmitter. The feature must be self-calibrated for each installation before use. 

Operation 

The feature must be first enabled using the command: 

configuration tool_MISMATCH_CONFIG=E,TTT 

 

where: 

E  is ‘1’ when the feature is enabled and E is ‘0’ if the feature is disabled. 

TTT  is the tolerance (decimal value between 0 and 255). The default value is 50, which should 

yield good results in most cases e.g. configuration tool_MISMATCH_CONFIG=1,50<CR> 

Calibration 

The feature requires calibration before first time use. to do this: 

1. Connect up the system and aerial. 

2. issue the command configuration tool_MISMATCH_CONFIG=1 

3. Confirm the 12-62 responds with “OK” 

4. 12-62 will auto calibrate on next transmission. 

5. Test by transmitting a message (probably CA1234560 1 test depending on protocol used). 

The 12-62 will respond with something like “RF:415:SP:762 CAL DONE”. 

6. Internally if the output power increases by the tolerance configured (50 by default) or the RF 

power module drive varies by 50, then an error is produced. 

7. Test the calibrated system by: 

• Connecting a different aerial or 

• Disconnecting the aerial. 

When a mismatch is detected the output such as  

390-415 : 874-762 

ER19 RF_LEVEL 

will be produced. In the example above 390-415 shows the recorded RF output level and the 

calibrated value. The difference is only 25 (415-390) and not enough to trigger a mismatch alarm. 

The second values shown (874-762) shows the recorded power module drive setting and the 
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calibrated setting. In this case the difference is 112 (874-762) and since this is above 50 an error is 

produced. 

In very rare cases a mismatched aerial may not be detected. This is because depending upon the 

length of the coaxial cable the impedance presented (varying with frequency and power setting) 

may appear to be suitably matched within the limits set by the command used above. This condition 

is close to impossible to detect in some cases using any method of detection (other than using a 

remote receiver to monitor signal strength). 

To overcome this if a problem is ever encountered you can either: 

• Change the length on the aerial coax slightly or 

• Change to a different aerial or 

• tighten the limits of the configuration tool_MISMATCH_CONFIG command. 
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Guidelines – Assignment of CapCode Codes 
 

 
General 

 

The following recommendations apply with greatest effect when the POCSAG transmitter is capable 
of batched messaging (such as the 12-62 and the 11-62). 

 
POCSAG transmission can be optimised on CapCode allocation. If a system is struggling for air time, 
then consider this carefully: 

 
POCSAG messages when batched are sent in the following manner. Note in the example below the 

message is deliberately started in the 4th frame (8 frames in a batch) 
 
S-II-II-II-AD-DD-DD-DD-II-S 

 
Where: 

• Codeword is a 32 bit data stream. 

• S=Sync Codeword (a 32 bit specially assigned number). 
• I=IDLE Codeword (a 32 bit specially assigned number). 

• A=ADDRESS codeword (holds the CapCode code). 
• D=DATA codeword (holds the actual message). 
• Frame = 2 codewords. 

 
Note: After the 576 bit preamble, the SYNC codeword is sent every 17 codewords, and at the end of 

transmission all 16 codewords between SYNCs are transmitted, regardless how small the payload is (all 
empty codewords are marked as IDLE). 
 

The Important Stuff 

 

The position that the address and data starts in depends on the last 3 bits of the CapCode code. 
 
Take the CapCode e.g. 1234567, use a tool like the windows calculator to convert to binary. Only look 

at the last 3 digits in the answer. 1234567 = 111. 111 binary = 7 decimal, add one to this and this will give 
you the frame position. 

 
If a CapCode is placed in frame 8, then only a single character can be sent before the message 
overflows into the next batch. 

 
Message “Hi” to CapCode 1234567 
S-II-II-II-II-II-II-II-AD-S-DD-II-II-II-II-II-II-II-S 

 
Message “1” to CapCode 1234567 

S-II-II-II-II-II-II-II-AD-S 
 
As you can see the available throughput on the channel is immediately halved. 

 
If the CapCode of 1234566 is used: 
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Message “Hi” to CapCode 1234566 
S-II-II-II-II-II-II-AD-DD-S 
 

Message “1” to CapCode 1234566 
S-II-II-II-II-II-II-AD-II-S 
 

Approximately 6 character of message can fit into a frame (without the ADDRESS), with the ADDRESS 
only a single character. 

 
Assigning Multiple CapCode codes to a Pager 

 

If you have the need to assign an additional CapCode to a pager, try to make additional CapCodes 
fit into the same frame as the other CapCode assigned to that pager. The pager wakes up only 

during its allotted frame period to check if there is a message for it, so CapCodes in different frames 
will result in the pager waking up more often depleting the battery much faster. 
 

Using Pagers on a Busy Network 

 

A pager will wake up when a preamble is detected, so regardless of CapCode, if there are lots of 
preambles being heard (like on the Telecom network), the battery life of the pager will be reduced. 
You can extend battery life by using a quieter channel. 

 
Summary 

 

If you wish to have good system performance (twice as good) and you are sending lots of batched 
messages, then select a CapCode that preferably falls within the first 3 frames. In Frame 3 there is 

room for about a 40-character message before overflowing into the next batch. 
 
If you are using a tone only pager, then the CapCode has negligible effect, they are all just as good. 

 
If you are using a numeric pager, use a CapCode that does not fall into frame 8, all others will be 

fine. 
 
If transmitter is under-utilised, or does not support batching, then the CapCode doesn’t really matter. 
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Guidelines - Antenna Selection and Installation 
 

 
When installing your Salcom product solution it is recommended to site the aerial at least a few metres 
away from the unit to avoid the possibility of RF feedback and causing potential problems with the 

transmitter operation.  
 

An external (outside) aerial is preferable and will provide better radio coverage.  A suitable antenna, 
such as ground independent 0.5 wave, is connected to the unit via the BNC connector on the end 
plate of the unit. The aerial connection should present a nominal load of 50Ω, with a VSWR of better 

that 1.8:1. Other options such folded dipoles, collinear and 0.25 with suitable ground plane are also 
suitable.  A high quality aerial installation will provide the user with performance and reliability. 

 
 
Note: The Salcom unit is designed to operate reliably over large distances, however the actual 

distance can vary depending on the type of location, obstructions, local radio interference and 

antenna system used. 

 

 
Recommended aerial suppliers: 

 

Region Supplier 

New Zealand Hi-Tec Aerials NZ Ltd 

http://www.hi-tec-aerials.co.nz/ 

 

Pacific Aerials Ltd 

http://www.pacificaerials.co.nz/ 

 

Australia RFI Wireless 

http://www.rfiwireless.com.au/ 

 

UK / Europe Procom (antennaPRO Ltd) 

http://www.procomuk.co.uk/ 

 

North America ?? 
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System Solutions 
 

 

System Overview 

The 12-62 / 12-84 / (12-34) combination can send signals for  

remote machinery control with additional outputs by adding 12-34(s). 

 

 

 

 

Typical Uses 

Using the 12-84 Relay Receiver, devices can be controlled remotely by sending commands from a 12-62 

transmitter to switch relays on or off.  It has two built-in relays and two open collector outputs. 

Where a greater number of relays are required to control additional devices, this can be achieved using the 

Salcom 12-34 Relay Output Module, which provides another four relays. This module can be "daisy-chained" 

to allow any number of relays to be controlled. 

System Components 

 

12-62-0000 VHF / UHF Transmitter 

12-62 transmitters are available as VHF or UHF, with user-programmable power outputs 

from 50mW to 4W. The 12-62 is capable of operating as NRZ or POCSAG and has 4 discrete 

inputs. 

 

12-84-7000 VHF/UHF Relay Output Receiver 

The 12-84-7000 is a scalable, high sensitivity paging receiver with serial connectivity and 4 

controllable outputs. 

 

12-34-0000 Relay Output Expansion Module 

The 12-34 is a low-cost relay output module which enables four relays to be remotely 

controlled using the Salcom relay control protocol.  

Relays 

Relays 

12-84 12-62 
Relays 

Inputs Serial / 

USB 

UHF / VHF 

12-34 

12-34 



P a g e  | 50 

 

   

12-62-0000 VHF & UHF TRANSMITTER  Product Manual 

   
Sea Air and Land Communications Ltd, 10 Vanadium Place, Addington, Christchurch 8024, New Zealand         February 2019 

 

System Overview 

The 12-62 / 12-84(s) combination can send signals to multiple sites to control remote 

machinery. Sites can receive a unique or common command signal. 

 

 

 

 

 

 

Typical Uses 

Using the 12-84 Relay Receiver, devices can be controlled remotely by sending commands from a 

12-62 transmitter to switch relays on or off.  It has two built-in relays two open collector outputs. 

Where multiple sites need to be controlled, more than one 12-84 can be used on the network. The 

12-84 sites can be programmed to follow a specific signal from the 12-62. The signal can be 

programmed to be unique to a site or common with one or more other sites. 

System Components 

 

12-62-0000 VHF / UHF Transmitter 

12-62 transmitters are available as VHF or UHF, with user-programmable power 

outputs from 50mW to 4W. The 12-62 is capable of operating as NRZ or POCSAG 

and has 4 discrete inputs. 

 

12-84-7000 VHF/UHF Relay Output Receiver 

The 12-84-7000 is a scalable, high sensitivity paging receiver with serial 

connectivity and 4 controllable outputs. 

 

 

12-84 12-62 
Relays 

Inputs Serial /  

USB 

UHF / VHF 

12-84 
Relays 

Relays 
12-84 
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System Overview 

The 12-62 / 12-90 / 12-84 solution using a 12-90 to get around obstructions such as trees, 

buildings etc. 

 

 

 

 

 

 

 

Typical Uses 

Where there are obstructions, the 12-90 can be used to get around these obstructions with its 

transceiver/repeater capabilities. It can receive a 12-62 message and forward this to a 12-84. 

Using the 12-84 Relay Receiver, devices can be controlled remotely by sending commands from a 

12-62 transmitter to switch relays on or off.  It has two built-in relays and two open collector 

outputs. 

System Components 

 

 

 

12-62-0000 VHF / UHF Transmitter 

12-62 transmitters are available as VHF or UHF, with user-programmable power 

outputs from 50 mW to 4W. The 12-62 is capable of operating as NRZ or POCSAG 

and has 4 discrete inputs. 

12-90-0000 UHF Transceiver and Repeater 

The 12-90 is a UHF transceiver, with a power output of up to 80mW. It can decode 

and encode 512 or 1200 baud, alphanumeric or numeric messages. 

 

12-84-7000 VHF/UHF Relay Output Receiver 

The 12-84-7000 is a scalable, high sensitivity paging receiver with serial 

connectivity and 4 controllable outputs. 

  

Serial / 

USB 

Inputs 

12-62 

12-84 

Relays 

12-90 

UHF  
UHF  
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 Protocols – Overview 
 

 
The 12-62 supports several protocols including the primary protocols listed below. 
 
Protocols Supported 

Salcom  

TAP (PET) 

TNPP 

ESPA 4.4.4 

Ascom 

Gaming 

Austco 

Match 

Gent 

GPS and Pulse Count 

SMS 

Scope 

Comp1 

Comp2 

11-10 

11-36/12-36 Messaging 

12-84 Receiver 

 

These protocols can be selected either through the programming tool (configuration tool) or through 
the use of serial commands. 

 
Note: Apart from the Salcom Protocol it is currently necessary to get your protocol unlocked prior to 

shipping from Salcom. Please talk to us regarding your protocol needs and we will be happy to assist. 
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Protocol Descriptions 

 
Salcom protocol is designed to optimise the control of Salcom products. The protocol is designed to 
provide a simple way to integrate Salcom product together in order to quickly achieve a solution 
implementation 

Telelocator Alphanumeric Protocol (TAP) is an industry-standard protocol for sending short messages 
via a land-line modem to a provider of pager and/or SMS services, for onward transmission to pagers 
and mobile phones. TAP defines an industry standard for sending alphanumeric messages to pagers. 

The Telelocator Network Paging Protocol (TNPP) is an industry standard networking protocol. Many 

paging providers exchange pages to earn more revenue and to provide for a greater coverage 
area. Pages are delivered between their paging systems via satellite, radio link or leased telephone 
lines. Most systems in current use are networked using the Telelocator Network Paging Protocol (TNPP). 

A group of connected paging terminals, running TNPP, will send, route and receive pages among the 
group. 

ESPA 4.4.4 is a standard protocol to exchange short messages between a PABX, nurse call system, 

fire alarm system, building control system, SCADA/PLC system or other device and an onsite paging 

system. It was developed in Europe in the 80’s and despite its age it is still widely used in hospitals,  

Ascom protocol allows your Salcom product to communicate and be integrated with the Ascom 
range of products and other third party devices that use the Ascom protocol. Ascom's broadcast 
paging solution provides a set of products targeted at healthcare, aged care, corrective and 

government facilities, where there is the need to send mission and life critical alerts to large groups of 
people who may be anywhere in a facility. 

Gaming protocol provides a method to monitor gaming machines and allow gaming machines, or 

their users, to be serviced with cash, drinks or action alarms. The 12-62 can concurrently manage 
repeating messages from 40 gaming machines. 

Austco protocol allows your Salcom product to communicate and be integrated with the Austco 
range of products and other third party devices that use the Austco protocol. Austco is a leading 

global provider of communication technology and software solutions for environments where 
communication is critical, such as healthcare and secure facilities. 

Match protocol when enabled replies when a defined message is seen. If there is an application to 

send a paging message when the serial string “TEST MESSAGE” is seen, then the “Match” protocol 
can be used. The matching “TEST MESSAGE” should be at the beginning of a received message. An 
incoming message is considered to be at the “start” if the previous message has been carriage return 

terminated, or there is a period of serial inactivity of at least 50mS.  
The protocol can also be configured so that a “Match Any” mode can be used allowing any arriving 

serial string to be paged out.         
A match on the end of the message can also be set, or configured so that the end of the message 
is not checked.             
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Gent is Honeywell’s protocol that allows their fire system components to communicate with each 

other. The protocol is designed to be open to allow flexibility in the choice of products, such as the 
12-62, that can be integrated in to their solutions. 

GPS and Pulse Count protocol is used for irrigation equipment transmitters. The protocol allows the 12-
62 to be connected to a GPS receiver. $GPGGA GPS messages are stored by the 12-62, so when 

required the position can be transmitted as a paging message. 

SMS protocol is different from an industry standard protocol, like PET/TAP or TNPP, because it is a 
scripted protocol which allows total control over all aspects of code and communication. The 

scripted protocol is GEN 1.0.4 

Scope Protocol allows the SALCOM transmitter to be interfaced to Scope Communications paging 

encoders and panels.  The serial command contains the CapCode/CAP code, message type, level 

and message information and, when using a 12-62’s with v2.9938 or higher, the baud rate.  The 

maximum message length is 30 characters. 

Format is [Message Type][Baud Rate][CapCode Code][Level]Message<CR>      

COMP1 allows non-paging protocol formatted ACSII strings to be sent as paging messages to 
contacts in the CapCode database.  As an example, this allows connection of the paging transmitter 
to a device with a serial printer output.  Due to the message being sent to all contacts successively, 

it is recommended that the database be kept to a minimum.   

Format is Message<CR> 

COMP2 defines the database contact in the serial string and messages are only sent to that 

contact.  Strings are delimited with either tilde or carriage return character and can be synchronised 

by prefixing the command with three <DEL> control characters.      

Format is Pager ID<CR>Message<CR> or Pager ID<Tilde>Message<Tilde>    

Note: Both COMP1 and COMP2 are non-verbose so don’t send acknowledgements.  Serial 

commands can be terminated in a carriage return for immediate transmission but any unterminated 

string is sent after a 10 second delay.  Full protocol details available on request. 

11-10 protocol is a variation of Salcom and PET protocols. It allows a 12-62 to directly replace the 11-
10 and 11-62 transmitter. It allows backwards and support for 1200 Baud messaging in the 12-32 input 
modules.            

11-36/12-36 Messaging protocol allows the 12-62 can be connected to the SALCOM 11-36, or 12-

36, Telephone Interface to allow the user to connect via a phone and initiate numeric calls or pre-

programmed alphanumeric calls.          

Note: The 11-36/12-36 messaging protocol is selected by choosing the “Salcom” protocol, which 

supports this protocol.            

12-84 Protocol is used by the POCSAG Receiver which outputs a serial string which can be decoded 
directly by the 12-62, usually for use as a Paging Store and Forward. The 12-84 protocol can also 
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support a similar formatted string from the Daviscomm POCSAG or Flex receivers.  

Note: The Daviscomm format is not added as a separate protocol as the 2 protocols need to be 

support concurrently, each being fed in a different serial port. 
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Trouble Shooting 
 

 
The following table may help in problem solving where necessary. 
 

Fault Check 

No illumination of Green LED Bad power supply connection 

Input activated but no transmission Software configuration incorrect 

Unit transmits but nothing received Poor aerial 

Wrong frequency 

Incorrect CapCode 

Incorrect baud-rate 

Power too low 

Unit too hot (the unit will also send out an error via 

the serial port) 

Too much vibration 

No RS232 serial communication Incorrect COM port connection selected 

Software configuration incorrect 

Cable faulty 

Unit starts, but does not complete 
transmission 

Poor supply voltage 

RF interference (the unit will also report an error 

on the terminal port) 
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Glossary 
 

 
 

Definition 

ASCII: Acronym for "American standard code for information interchange," a method of 

representing upper and lower letters in addition to numbers and special symbols. 

BNC connector: A miniature quick connect/disconnect radio frequency connector used for 
coaxial cable. 

Debounce: A time delay between an input being triggered and an action taking place. A 
programmable debounce delay can be added to allow an input signal to settle before it is used. 

Duty cycle: A measure of the fraction of one transmission period the transmitter is transmitting a 
signal. Duty cycle is commonly expressed as a percentage or a ratio. 

NRZ (Non-return-to-zero): Refers to a form of digital data transmission in which the binary low and 
high states, represented by numerals 0 and 1, are transmitted by specific and constant DC (direct-

current) voltages. 

POCSAG: A standard set of code and signaling formats for radio paging. The POCSAG standard, 

provides for transmission speed of up to 2,400 bps, using channels of 25 kHz in the 150. 

RS-232: A standard for serial communication transmission of data. 

Universal Serial Bus (USB): A common interface that enables communication between devices and 
a host controller such as a personal computer (PC). 

Telelocator Alphanumeric Protocol (TAP): An industry-standard protocol for sending short messages 

via a land-line modem to a provider of pager and/or SMS services, for onward transmission to 
pagers and mobile phones. TAP was initially known as Motorola Page Entry (PET). 

VSWR (Voltage Standing Wave Ratio): is a measure of how efficiently radio-frequency power is 
transmitted from a power source, through a transmission line, into a load (for example, from a 

power amplifier through a transmission line, to an antenna). 

Watchdog (timer): An electronic timer that is used to detect and recover from embedded system 

malfunctions. 
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Accessories and Related Products 
 

 

Name Description Part Number 

Serial 

Programming 

Lead 

An RJ-12 (12-62 connection) to DB9 (computer connection) 

RS232 (serial) Programming Lead for use with the 12-62, 12-

84 and 12-32. 

12-45-0000 

USB 

Programming 

Lead 

USB Mini (12-62 connection) to USB (computer connection) 

programming lead for use with 12-62. 

Supplied with 

product. 

Programming 

Tool 

Salcom 1262 configuration tool configuration tool, 

downloadable from 

https://www.salcom.com/products/transmitter-vhf-uhf-4w-

5w/ 

Website 

download 

Terminal 

Screw Block 

Terminal screw block for the external power supply source.  Supplied with 

product. 

RJ45 Single 

Ended Cable 

An RJ45 cable to allow the connection of the external serial 

source.  

Supplied with 

product. 
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Technical Specification 
 

 

Technical Specification 

12-62-0000 – VHF / UHF Transmitter  

Frequency Range 148 - 164MHz - VHF (Model No. 12-62-0150) 

427.5 - 475MHz - UHF (Model No. 12-62-0450) 

Frequency Selection User configurable 

Power Supply +13.8V typical (11 to 15 VDC range) 

Power Consumption Low Power Mode: 17.5mA 

Standby: 40mA 

Transmit: 1.2A @ 4W 

Transmit Power 4W, 2W, 1W, 500mW, 250mW, 100mW, 50mW (5W on request) 

Channel Spacing 5kHz, 6.25kHz, 10kHz, 12.5kHz, 25kHz 

Modulation FSK with NRZ data 

Deviation ±2.25kHz or ±4.5kHz 

Transmit Duty Cycle 50%; Maximum 5 minutes on time 

Baud Rates 512, 1200 

Message Format POCSAG 

Configuration Application 12-62 configuration tool 

Programming Cable Mini USB 

12-45-0000 (RJ12 to DB9) 

Can be used with a USB to RS232 DB9 Serial Adapter Cable 

Serial Port 9600 , N, 8, 1; RS232 / USB 

Other serial protocols available on request 

Serial Protocols Salcom; TAP (PET); TNPP; ESPA 4.4.4; Ascom; Gaming; Austco; Match; 

Gent; GPS & Pulse Count; SMS; Scope; Comp1; Comp2; 11-10; 12-36; 12-

84 

Discrete Inputs 4 (Ground activated) 

Other I/O PTT In; PTT Out (50mA max); External Modulation (0 - 5V ±1V) 

Connectors Serial Port (RS232) = RJ12 (6P6C) 

Input / Outputs = RJ45 (8C) 

Programming = mini USB  

Power Connector 2-way plug & socket, screw connections (supplied) 

Environmental Protection Not suitable for outdoor use and should be protected from adverse 

environmental conditions 

Operating Temperature -20ºC to +50ºC (-4ºF to +122ºF) 

Indicators Power LED (Green) 

   - Slow Flashing = Normal Operation 

   - Rapid Flashing = Low Supply Voltage 

Status LED (Red)  

   - On = Transmitting 

   - Flashing = Error Condition 

Weight 316g 

Enclosure Dimensions 100mm x 130mm x 30mm (WxDxH) 
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Enclosure Material Extruded aluminium 

Colour Matt black 

Type Approvals AS/NZS 4769.1:2000 + Amendment 1:2002 (RF) 

EN 300-224-2 (RF) 

FCC CFR47 Part 90 (RF) - UHF only (Model No. 12-62-0450) 

EN 301 489-2 V2.1.0 (EMC) 

EN 60950-1:2006 (Safety) 
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How to Contact Us 
 

 

Sea Air and Land Communications (Salcom) Ltd 

10 Vanadium Place 

Addington 

Christchurch 8024 

New Zealand  

T:    +64 (0)3 379 2298 

W:   www.salcom.com 

E:     support@salcom.com 

E:     sales@salcom.com 

 

 


